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Audinate is not liable for any loss or damage that may be suffered or incurred in any way as a result of
acting on information in this document. The information is provided solely on the basis that readers will be
responsible for making their own assessment, and are advised to verify all relevant representation,
statements and information with their own professional advisers.

Software Licensing Notice
Audinate distributes products which are covered by Audinate license agreements and third-party license
agreements.

For further information and to access copies of each of these licenses, please visit our website:

www.audinate.com/software-licensing-notice

http://www.audinate.com/software-licensing-notice
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About Audinate
Audinate revolutionizes AV systems to enable its customers to thrive in a networked world. Audinate's
patented Dantemedia networking technology has been adopted by the leadingmanufacturers in the
professional audio/visual industry.

Dante is used extensively for live performance events, commercial installation, broadcast, recording and
production, and communications systems.

Audinate offices are located in US, UK and Australia. Visit www.audinate.com for the latest news and
information on the company.

Dante is Digital Media Networking Perfected.

About Dante
Audinate’s Dante technology provides high performance digital media networking that meets the quality
and performance requirements of professional live sound, AV installations and broadcast and recording
systems.

Designed to fully exploit the capabilities of today and tomorrow’s networking equipment, Dante provides
media transport mechanisms that eliminatemany traditional audio network design restrictions. Dante
makes it easy to set up robust, flexible digital audio networks with virtually unrestricted performance. A
Dante network can be designed with mixedGigabit and 100Mbps network speeds, simultaneously support
audio with different sample rates and bit depths, and even allow the design of network zones with different
latencies.

Dante is built on Internet Protocols — not just Ethernet. Because it uses standard IP over Ethernet, Dante
is capable of running on inexpensive off-the-shelf computer networking hardware, and with the use of
standard QoS can share installed networks with other data and computing traffic.

Dante provides sample-accurate synchronization and can deliver the very low latency required by
professional audio. Dante’s network-centric, audio-independent approach to synchronization allows
perfectly synchronized playout across different audio channels, devices and networks, even over multiple
switch hops.

Dantemakes networking a true plug-and-play process, allowing automatic device discovery and system
configuration. Dante-enabled devices will automatically setup their network configuration and advertise
themselves and their channels on the network, reducing complicated, error-prone set-up procedures.
Instead of ‘magic numbers’, networked devices and their input and output signals can be named tomake
sense to the user.

Dante is not restricted to allowing configuration and transmission of audio channels. Dante also provides
mechanisms to send or receive control andmonitoring information across the Dante IP network, including
equipment-specific messages and control specified and developed by a particular manufacturer.

With its strong foundations and links to current and evolving network standards, Dante is able to deliver a
level of future proofing otherwise unavailable in other types of digital audio transportation. Continued
evolution of its networking technology is an integral part of the Dante roadmap.

Dante technology is available in ready-to-implement hardware and software products, reference designs
and development APIs.

For more information, please visit the Audinate website at www.audinate.com.

http://www.audinate.com/
http://www.audinate.com/
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Introduction

About Dante Controller
Dante Controller is a software application provided by Audinate which allows
users to configure and route audio around Dante networks. It is available for
Windows andOS X (seeMinimum System Requirements for more details).

Once you install Dante Controller on your PC orMac and connect it to a Dante
network, you can use Dante Controller to:

n View all Dante-enabled audio devices and their channels on the network

n View Dante-enabled device clock and network settings

n Route audio on these devices, and view the state of existing audio routes

n Change the labels of audio channels from numbers to names that suit you

n Customize the receive latency (latency before play out)

n Save audio routing presets

n Apply previously saved presets

n Edit presets offline, and apply as configurations for new network deployments

n View and set per device configuration options including:

o Changing the device name

o Changing sample rate and clock settings

o Viewing detailed network information

o Access the device web page to upgrade firmware and license information (where supported)

o Identify a device for example by flashing LEDs (where supported)

n View network status information, including:

o Multicast bandwidth across the network

o Transmit and receive bandwidth for each device

n View device performance information, including latency statistics and packet errors

n View clock status information for each device, including frequency offset history and clock event
logs

What'sNew
v3.6.2

n Support for AES67-enabled devices.

o The Clock Status View now includes an AES67 Status column

o The CreateMulticast Flow panel now allows the creation of AES67multicast flows

o There is a new AES67Config tab for AES67-enabled devices

o The Device View > Receive Tab now includes AES67multicast transmit flow channels (shown
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in blue)

o The Network View > Routing Tab now includes AES67 transmit channels (shown in blue)

n Support for Avid DNT-192 expansion cards.

Previous releases

v3.5.6
n Dante Controller now displays Ultimo devices in orange text when they are in upgrademode.

n Device names can now start with a numeric character.

n OS X 10.10 is now supported.

v3.5.1
n Dante Controller now checks (at startup) the version of the Dante Control andMonitoring service

(conmon) that is installed on the computer. If the conmon version is not correct for the installed ver-
sion of Dante Controller, the user is prompted to update the conmon version, by reinstalling Dante
Controller.

v3.5.0
n Presets have been enhanced. You are now able to filter the parameters that are saved into presets,

edit preset files offline (this effectively allows you to use Dante Controller as an offline configuration
tool), and apply the saved parameter sets as 'device roles' to any compatible devices, on any net-
work (where supported). See Presets for more information.

n For supported devices, the new Device View > Latency tab allows you to view a histogram of audio
packet latency for each transmitter that the device is subscribed to.

n For supported devices, Clock Status Monitoring allows you to view a histogram of clock stability for
the device.

n Dante Controller can now be connected to primary and secondary networks (where applicable),
enabling full control over redundant devices should the primary network fail.

n Channel Groups allow you to group device channels into sets of 16.

n A new tab, Network Status, displays network related information for all devices on the network.

o The 'Clear Counters' button on the Device View > Status tab can be used to clear packet error
history for the device.

n The Device Status tab is now called Device Info.

n The Clock Status tab has been enhanced.

n The Events tab has been enhanced. Events can now be filtered by severity, and the event log icon in
the status bar displays notifications for new events.

n The new Status Bar displays the status of connectivity to the primary and secondary networks, mul-
ticast bandwidth (previously shown in the toolbar), and notification icons for the event log and the
clock status monitor.

n New look and feel.

MinimumSystemRequirements
The tables below list theminimum system specifications for your computer to be able to use Dante
Controller.
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Disclaimer: It is possible that your computer may meet the requirements below, but suffer from some
other individual performance limitation related to its particular hardware. Please seek the advice of your
computer support administrator.

General

Component Recommended Minimum Requirement

Processor 1GHz or better

Memory 512Mbyte of RAM

Network Standard wired Ethernet network interface (100Mbps or Gigabit). Wireless LAN (Wi-
Fi) Ethernet interfaces are not supported

Windows

Component Recommended Minimum Requirement

Operating
System

Windows 7 (SP1 and above), 8, 8.1 and 10

NOTE: Both UTF-8 and Unicode are supported EXCEPT for host or device
names; the DNS standard does not support Unicode for these

Mac OSX

Component Recommended Minimum Requirement

Operating System Mac OS X 10.7.5, 10.8.5, 10.9.5 and 10.10.5
NOTE: Intel architecture only; PPC architecture is not supported

Note: If you intend to also install Dante Virtual Soundcard on the samemachine as Dante Controller,
you will require amachine whichmeets theminimum system requirements for Dante Virtual
Soundcard.

Operating SystemUpdates
Ensure your PC orMac has the latest Windows or Apple updates installed.

Firewall Configuration
Firewall configuration forWindows Firewall andMac OS X built-in firewall is automatically handled during
installation.

Dante Controller communicates over UDP over the following ports:

n Dante Control andMonitoring: 8700-8705, 8800

If you are using a third-party firewall product, use the port information provided above to configure it
accordingly.
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MonitorRequirements
n A display resolution of at least 1024 x 768, with a screen size of at least 19” is recommended for

Dante Controller.
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Installing Dante Controller

Downloading Dante Controller
Dante Controller is available for download from Audinate’s website.

To download a copy of Dante Controller:

1. Go to the Audinate website: www.audinate.com.

2. Navigate to Products > Dante Controller.

3. Under ‘Download’, choose your operating system.

4. Click the red download button.

This will take you to the appropriate Dante Controller release page for your operating system.

Click the link under ‘File downloads’ to download the Dante Controller installer.

Installing Dante Controller onWindows
Once you have downloaded the self-installing Dante Controller file, navigate to the directory where you
have downloaded it (e.g. Desktop).

To install:

1. Ensure you are logged on to your PC as an administrator.

2. Navigate to and double-click the Dante Controller installer file.

3. Read the license agreement. If you agree to the terms, select the 'I agree' checkbox and click
Install. If you do not agree to the terms, click Close.

4. Confirm / acknowledge any Windows security prompts that are displayed.

Dante Controller will then be installed. Dante Controller will be added to the start menu, under
'Audinate'.

Installing Dante Controller onMacOSX
To install Dante Controller onMac OSX:

1. Double-click the Dante Controller .dmg file. A drive icon will appear on your Desktop Finder window.
Double click on this to open.

2. Double click the Dante Controller .pkg. This will run the installer.

3. Read the license text, and if you accept the terms of the agreement, click Agree.

If you do not accept these terms, click Disagree to terminate the installation.

Uninstalling Dante Controller
You should not need to uninstall Dante Controller before installing a new version.

However, if you do wish to uninstall Dante Controller:

http://www.audinate.com/
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Windows
Navigate to Control Panel > Programs and Features, select Dante Controller and click Uninstall.

Note: Two other Dante features, 'Dante Control andMonitoring' and 'Dante Discovery', may still be
present in the programs list after uninstalling Dante Controller. Do not uninstall these features if they
are present - they are required by other Dante software applications (for example, Dante Virtual
Soundcard, Firmware UpdateManager, and third-party Dante control applications). They will be
removed automatically if they are no longer required.

Mac OS X
Use the Uninstall tool available in the .dmg file.
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Dante Basics

Discovery and auto-configuration
When aDante-enabled device is connected to an IP/Ethernet network, it will automatically:

1. Configure its IP address

2. Advertise itself to allow automatic discovery

Within seconds of a Dante-enabled device connecting to a network, Dante Controller will automatically
discover and display the device, allowing you to configure channels and route audio.

Automatic network configuration
A Dante-enabled device connected to a network will automatically setup its own network configuration,
including its IP address.

If the network has a DHCP server, whichmay be the case for installed networks, it will receive its IP
configuration using the standard DHCP protocol.

On a network without a DHCP server, whichmay be the case for temporary or smaller networks, the
Dante-enabled device will automatically assign itself an address using link local protocols, in the same
way PCs and printers often do.

Automatic discovery
A Dante-enabled device will advertise information about itself to other Dante devices and Dante Controller,
including:

n Device name

n Audio channel labels

n Number of audio channels

n Sample rates and bit depths

This information can be seen when viewing a device on Dante Controller, and allows Dante devices to
determine compatibility with other devices, such as compatible sample rates to allow audio to be routed.

Device Channels
A Dante device has a number of channels associated with it. These are either transmit (Tx) or receive (Rx)
channels. Receive channels and devices are listed down the left side of the grid. Transmit channels and
devices are listed along the top of the grid.

Transmit channels are advertised on the network. A receiver uses this advertisement to establish a
subscription to the channel. A transmit channel can be sent to multiple receivers using unicast or
multicast.

Receive channels are connected to transmit channels via a subscription. Each receive channel will receive
audio over the network from at most one transmit channel.
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Subscribing to Audio Channels
In the Routing View, a blue square at the intersection of an Rx and a Tx channel indicates that is it possible
to create an audio route between those channels. A grey square indicates that it is not possible to create a
route between those channels. This may be because of amismatch in sample rate between the transmitter
and receiver, or because a device cannot route to itself.

When you click a blue square at the cross-point between a transmit channel and a receive channel, a

subscription will be created, and a green tick will appear in thematrix cross point. Youmay initially see

a grey hourglass icon (usually very briefly) to indicate that the subscription is in progress.

If there is a problem with the subscription, either a warning or an error icon may appear. If many

devices have been subscribed at the same time, a yellow pending iconmay appear temporarily. Hover
themouse over subscription icons to see a related tooltip (see Subscription Tooltips).

Note: Subscriptions can also be created in the Device View. This is covered in the Device View
section (Device View is NOT the same as Device Status View).

Subscribing to Multiple Audio Channels at once
To subscribemultiple channels at the same time, hold down the Ctrl key and click the [-] symbol at the top
left corner of the intersection between the two devices. All possible channels will be subscribed at the
same time (see the figure in Expanding the Routing View).

Unsubscribing Audio Channels
To unsubscribe an audio channel, click on the cross-point containing a subscription. The subscription icon
will be removed and revert to a plain blue square.

Subscription Status
The symbol displayed at the intersection of the Tx channel and the Rx channel in the Routing View
provides information on the status of the subscription or connection, as follows:

In progress The subscription is in progress

Subscribed Connection is established and fully functional

Warning The subscription is unresolved, typically because the transmitting
device is not visible on the network (for example, because it has
been removed, or switched off)

Error An error has occurred - for example, there is insufficient bandwidth
to establish the subscription

Pending Device is part-way through setting up subscription. Most commonly
seen when subscribingmany channels at a time

Note: The status of a subscription can change after it has been initially established, due to changes
in the network or changes in other devices.

Subscription Tooltips
Hovering themouse over a subscription icon in the Routing tab displays a tooltip containing information
about the subscription.
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If there is no problem with the subscription, the tooltip will display the Rx channel and device name, plus
the Tx channel and device name (for example, 'kick@Monitor-Console <- 01@Stagebox-2').

Other messages are displayed if the subscription is in any other state.

Some commonmessages are:

n 'Incorrect channel format: source and destination channels do not match'

The receiver and transmitter are set to different sample rates.

n 'Mismatched clock domains: The transmitter and receiver are not part of the same clock domain'

One of the devices is configured with sample rate pull-up/down that does not match the other device.

n 'Tx Scheduler failure'

This is typically because you are trying to use sub-millisecond latency over a 100Mbps network link
(1msec is theminimum supported latency over 100Mbps links).

n 'No Receive flows: receiver cannot support any more flows'

This will be seen if the receiver is subscribed to toomany devices (devices typically do not support
the same number of flows as they do channels). See Routing Audio > Flows for more information.

n 'Nomore flows (TX): transmitter cannot support any more flows'

This will be seen if toomany devices are subscribed to the transmitter. See Fanout for more
information.

Differentiating between input and output channels
Channels are classified according to whether they put audio data onto, or take audio data off the network:

n A channel that puts audio data onto the network is known as a transmitting, Tx or output channel.

n A channel that takes data off the network is known as a receiving, Rx or input channel.

Device Namesand Channel Labels
In Dante, devices and audio channels are identified by names and labels, not “magic numbers”. Device
names and channel labels can be customized.

n Dante routing is performed using the device names and channel labels. A receive channel can be sub-
scribed to the name of a transmit channel at a device.

Example: “Analog L@my-transmitter” describes a channel labelled “Analog L” on a device
named “my-transmitter”. Device names must be unique on a Dante network. Channel labels
must be unique on the device.

n If a device or channel is renamed, Dante routing considers it to be a different device or channel. If a
new device or channel is then given the old name, Dante routing will route from the new device in
place of the previous device.
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Example: The power supply on “stage-box” fails and “stage-box” needs to be replaced. The
old “stage-box” is removed, and a new box is plugged in and named “stage-box”. Dante
receivers previously subscribed to the old “stage-box” will now automatically restore their
subscriptions to the new “stage-box”.

n Device names must be unique on the network. If you attempt to rename a device using Dante Con-
troller to a name that is already in use on the network, Dante Controller will notify you and reject the
name change.

Example: There is an existing device on the network called “MY16-slot1”. If user attempts to
rename another device to “MY16-slot1” Dante Controller will notify you that the name is already
in use. The device will not be renamed.

n If a new device is added to the network with a name that already exists, a name conflict is detected,
and one of the devices will rename itself by appending (2) to its name. This device will not be able to
transmit audio until it is renamed.

Note: A device that has been renamedwith (2) appended (e.g. “MY16-slot1(2)”) will not be able to
transmit audio until it is renamed. The device namemust be changed by the user to be a valid non-
conflicting name before the device can become fully functional.

Rules for Names and Labels
n All Dante names and labels are up to 31 characters in length. Name and label comparisons are case-

insensitive; “Guitar” and “guitar” are treated as the same label. Unicode and non-roman char-
acters are not supported.

n Device names should follow Domain Name System (DNS) hostname rules. Legal characters are A-
Z, a-z, 0-9, and '-' (dash or hyphen).

n Tx channel labels may use any character except '=' (equals), '.' (full stop or period), or '@' (at). Tx
channel labels must be unique on a device. Tx channel labels do not need to be unique on the net-
work as they are always qualified by device (channel@device).

n Rx channel labels follow the same rules as Tx channel labels.

Routing Audio

Routing Terminology
n Device: A devicemeans a Dante-enabled device, andmore specifically that component of the audio

equipment that implements the Dante interface. A Dante device typically has Tx and Rx channels
and other routing-related properties.

n Transmit (Tx) channel: A transmit channel transmits audio from the audio hardware onto the net-
work.

n Receive (Rx) channel: A receive channel receives audio from the network and sends it to the audio
hardware.

n Flow: Dante audio routing creates flows. Each flow carries several channels of audio from a trans-
mitter to one or more receivers. Unicast routing creates flows to single receivers. Multicast routing
creates flows that can be received by multiple receivers. Multicast flows are assigned IDs enabling
them to be identified in Dante Controller.
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n Unicast routing: Unicast flows are point-to-point from a single transmitter to a single receiver.
Unicast flows typically have room for 4 channels of audio.

n Multicast routing: Multicast flows are one-to-many from a single transmitter to any number of receiv-
ers. Use Dante Controller to choose which channels are to bemulticast. Unlike unicast routing, mul-
ticast flows consume network bandwidth even if there are no receivers, but do not require additional
bandwidth to addmore receivers.

n Subscription: A subscription configures a receive channel to receive audio from a transmit channel
on another Dante device.

n Subscription status: For a receive channel, subscription status indicates whether it is subscribed,
whether it is receiving unicast or multicast audio, whether the subscription is OK, or whether an error
has occurred.

Subscription
Dante routing is performed by associating a receiving (Rx) channel with a transmitting (Tx) channel. This is
called subscription.

Example: Route Tx channels 1 and 2 (labeled “Audio L” and “Audio R”) on the device labeled
“Source” to Rx channels 3 and 4 on the device labeled “Dest”.

Rx channels 3 and 4 on “Dest” are subscribed as follows:

n 3. Audio L@Source

n 4. Audio R@Source

Dante will perform the necessary audio routing to deliver the audio from the Tx channels to the Rx
channels.

Redundancy
Many Dante devices support redundant audio routing. These devices have two network interfaces, labeled
primary and secondary. Primary interfaces should be connected to one physical network. If redundancy is
being used, secondary interfaces should be connected to a second separate network. Secondary
interfaces cannot communicate with primary interfaces.
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If the secondary network is connected to a device that supports redundancy, it is enabled automatically.
The same audio data is transmitted on both the primary and secondary networks simultaneously. In the
event of a failure on one network, audio will continue to flow via the other network.

Note: Dante redundancy requires that both the primary and secondary interfaces on any redundant
device are connected using the same link speed. For example, if the primary interface is connected to
a 1Gbps switch port, the secondary interfacemust also be connected to a 1Gbps switch port.
Similarly, if the primary interface is connected to a 100Mbps switch port, the secondary interface
must also be connected to a 100Mbps switch port.

Note: Dante devices that do not support redundancy must be connected to the primary network only.

Audio Formats
Most Dante devices support a range of audio formats (sample rates). Devices can usually be switched
between audio formats, but will not support more than one at a time.

It is only possible to set up a subscription between channels which have a common audio format.
Channels on devices with incompatible formats will be shown in grey, and will not be routable.

Flows
Dante audio routing creates 'flows'. Each flow carries one or more channels of audio from a transmitting
device to one or more receiving devices. There are two types of flow, unicast andmulticast.

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 4
channels of audio. Unicast flows are set up when a receiver subscribes to an available audio channel, and
are automatically removed when the receiver unsubscribes from all channels in that flow.

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned
IDs, enabling them to be identified in Dante Controller, and to facilitate their removal. In contrast to unicast
flows, multicast flows must be set up on the transmitting Dante device before receivers can subscribe to
these flows.
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Advanced Routing: Using Multicast
Dante routing is unicast by default. This means that a separate flow is set up between each transmitter and
receiver. If several receivers are all subscribed to the same channels of a transmitter, it may sometimes be
more efficient to usemulticast.

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that the
audio flow is flooded throughout the network. If many receivers want the same channels, usingmulticast
can reduce overall network use, especially on the transmitter, because only one copy of each audio
channel needs to be sent, rather thanmany.

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a new
multicast flow is created containing the channels that a receiver is currently receiving as unicast, the
receiver will switch over to receiving audio from themulticast flow and the unicast flow will be removed.

ClockSynchronization
All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to
synchronize their local clocks to amaster clock, providing sample-accurate time alignment throughout the
network.

One Dante device will be elected as the PTP Master Clock for the network; all other Dante devices act as
a PTP Slave Clocks to the electedmaster clock. Althoughmany Dante devices may be capable of
becoming PTP Master Clock, only one device will win the election. Devices with clock inputs (e.g. Word
Clock or AES3) will be preferred in the election process. A gigabit connected device is preferred over a
device connected via 100Mbps. A tie-breaker rule of the lowest MAC address is used if several equivalent
candidatemaster clocks are available. The election process may be overridden by manually setting
'PreferredMaster' on a device.

Dante Clock Types
Each Dante hardware device can derive its clock from either its high-quality onboard clock circuit, or an
externally connected word clock. In the case of Dante Virtual Soundcard, the computer’s clock will be
used.

Clock Settings

Enable Sync To External
A Dante device set to 'Enable Sync To External' will use the external word clock from its host equipment to
tune its onboard VCXO. A Dante device with this attribute set will become the PTP Master Clock, unless
there is another Dante device present with 'PreferredMaster' set.

Preferred Master
Sometimes it may be necessary to force a particular device to provide the PTP Master Clock. A Dante
device with 'PreferredMaster' set will always be chosen as the PTP Master Clock. If more than one device
has 'PreferredMaster' set, the device with the lowest MAC address will be chosen.

Note: If device A is deriving its clock from an external word clock source ('Enable Sync To
External'), but device B is set as PreferredMaster, device A will lose sync with the Dante network
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and will eventually bemuted - unless device B is also deriving its clock from the same external
source as device A.

Clock Status

Clocking and Synchronization in Redundant Networks
In a redundant network, the clock synchronization protocol operates over both primary and secondary
networks. Each network will have a designated PTP master clock; usually this will be the same device on
both networks. If this is not the case (e.g. if a non-redundant device is designated PreferredMaster) then
one device will bridge the clock synchronization information from the primary to the secondary network,
ensuring that all devices derive their clock from the same source. Redundant PTP Slave clocks will
synchronize their local clocks based on information from one of the networks they are connected to. In
event of a failure on one network, a redundant device will continue to receive clock synchronization
information over the other network.

Latency
In Dante, variation in latency in the network is compensated for at the receiver. Each receiver has a device
latency setting. This setting defines the latency between the timestamps on the incoming audio samples
and when those samples are played out.

The typical default latency for a Dante device is 1msec. This is sufficient for a very large network,
consisting of a Gigabit network core (with up to 10 hops between edge switches) and 100megabit links to
Dante devices. Smaller, Gigabit-only networks can use lower values of latency (down to 150 µsec for very
fast devices, such as PCIe cards). Recommended latency settings are displayed in Dante Controller, and
may also be found in the documentation accompanying the product.

Latency is set on the receiver. However, when a subscription is made, there is an automatic negotiation
process between the receiver and the transmitter, to ensure that the latency for the subscription is high
enough to prevent packet loss.

For example, Ultimo devices support a minimum of 2ms latency. If a faster device (such as a PCIe card) is
set to 1ms latency, and is then subscribed to an Ultimo transmitter, the latency used for the subscription
will be 2ms, which is theminimum supported latency for the subscription. Subscriptions to other devices
(such as a Brooklyn II device) will be set at 1ms (or whatever latency the receiver is set to). This
effectively makes the device latency setting a 'default' latency, which is used unless the transmitter
doesn't support it.

Note: Theminimum latency available for a device connected to a 100Mbps network port is 1msec.

Using a latency lower than 1msec over a 100Mbps link will result in a subscription error, with the
tooltip 'Tx Scheduler Failure'.

Latency Monitoring
Dante Controller provides latency monitoring for supported devices. For more information, see Latency
Tab.
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Latency and Dante Virtual Soundcard
Dante Virtual Soundcard allows a standard AppleMac orWindows PC to function as a Dante device.
Because Dante Virtual Soundcard runs on a general purpose computer without special hardware to support
Dante timing requirements, additional latency needs to be added to connections received from aDante
Virtual Soundcard transmitter.

Dante Virtual Soundcard is configured with custom latency values for reliable operation. Dante devices
with Rx channels that are subscribed to Tx channels from aDante Virtual Soundcard transmitter will
automatically configure themselves to use these higher latency values for those channels only. The
latency on all other subscriptions on the receiver is unaffected.

Dante Control andMonitoring
In addition to automatic configuration and discovery, audio transport and routing, Dante-enabled devices
can also be controlled andmonitored in various ways. This includes being able to view and change specific
parameters, such as clock configuration settings. Dante devices are also capable of sending status events
that can be viewed using Dante Controller. Status events include changes in clock status, or network
interface changes.

Note: The computer service that manages control andmonitoring is called 'ConMon' or 'Dante
Control andMonitoring'.
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Starting Dante Controller

Where to find the Dante Controller application

Windows
By default Dante Controller will be installed in

C:\Program Files\Audinate\Dante Controller\

It can be started in several ways:

n Using the Start menu: Start > Programs > Audinate > Dante Controller > Dante Controller

n Run by going to Start > Run and entering
C:\Program Files\Audinate\Dante Controller\DanteController.exe
in the dialog box

n Navigate to the directory where it is installed, and double-click the Dante Controller icon:

Mac OSX
The Dante Controller application will be installed in the Applications folder.

To start:

n Navigate to Applications folder, and double-click the Dante Controller icon:

Or:

n Drag the icon to the Dock and click on it

Configuring Dante Controller

Network Interface Selection
Dante Controller can communicate with other Dante devices on the primary network, or the secondary
network, or both. Dante Controller needs to know which of the network interfaces of the host computer is
connected to each Dante network.

The first time Dante Controller is run, youmay be presented with the Configure Dante Interfaces dialog
box (shown below), providing a list of interfaces from which to select the primary and secondary Dante
interfaces. Once interfaces have been selected, they are remembered for future use, and this dialog box
will not be shownwhen Dante Controller is run subsequently.
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To display this dialog at any other time, click the button in themain toolbar.

Network Interface Configuration Guidelines

Primary only (non-redundant) Dante network
If you only have a primary network, you can only connect one interface to the Dante network.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to
the switch via their primary interfaces. This is a typical non-redundant Dante network.

If the laptop has two network interfaces, either can be used.
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Primary and secondary Dante networks (redundant configuration), only one
network interface on the host computer
If you have primary and secondary (redundant) networks, but only one network interface on your computer,
you should set your computer's network interface as the primary interface. This ensures that you can
control any non-redundant devices, and see full connection information for any redundant devices that are
connected to non-redundant devices.

If a problem does occur, and you lose connectivity on the primary network, you can connect instead to the
secondary network, to maintain control over your devices. This entails changing the physical connection
(i.e. physically connecting your computer to a switch on the secondary network), and changing the
interface selection in the Configure Dante Interfaces dialog.

Example
In the example below, the laptop (running Dante Controller) is connected to the switch via one interface
only, which is set as the primary Dante interface.

The two Dante devices are connected to the primary switch via their primary interfaces, and to the
secondary switch via their secondary interfaces. The two switches are not connected to each other. This
is a typical redundant network configuration for computers with only one network interface.

Note: When connected to the secondary network, you will not have control over devices that are
only connected to the primary network (i.e. non-redundant devices, or Dante Virtual Soundcard). You
will see the device names in the Network view, and in subscription dialogs (for example, the Device
View > Receive and Transmit tabs) but you will not be able to view or edit device configuration for
those devices. Also, if themaster clock is only connected to the primary network, its namewill not
resolve in the 'Master Clocks' section of themain window tool bar, it will be shown as aMAC address
string.
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Primary and secondary networks (redundant configuration), two network interfaces
on the host computer
if you have primary and secondary networks, and two network interfaces available on the host computer,
you should connect one interface to each network. This means that you will always have full control of all
redundant devices, even if the primary network fails.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to
the primary switch via their primary interfaces, and to the secondary switch via their secondary interfaces.
The two switches are not connected to each other. This is a typical redundant network configuration for
computers with two (or more) network interfaces.

Note: Youmust be connected to a standard wired Ethernet network in order to use Dante Controller.
Wireless and other non-standard wired Ethernet interfaces will not appear in the Configure Dante
Interfaces dialog.

Note: All Dante applications on the same computer have a shared understanding of which interface
is the primary Dante interface. For example, if you have installed Dante Virtual Soundcard on the
same PC as Dante Controller, and a new primary interface is selected from within Dante Virtual
Soundcard, Dante Controller will automatically switch to the newly selected interface, and begin
operating on that interface.
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Using Dante Controller
Dante Controller presents twomain types of view: Network View and Device View.

Important: After making changes to Dante network routing (e.g. subscriptions, device names,
channel labels etc.) please wait at least 5 seconds before disconnecting or powering down any
affected devices. This ensures that the new information has been properly saved to the devices.
Device configuration (e.g. sample rates, latency, clock settings) are saved instantly.

Note: Mac OS X users: Please note that the key combinations shown below are forWindows users.
When using Dante Controller on aMac, please use the “Command (CMD)” or “Apple” key instead of
the “Control” key when following the instructions below, and substitute standardMac key
combinations where applicable – see the Dante Controller menu for details.

NetworkView
WhenDante Controller is started, it opens at the Network View, with the Routing tab selected.
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Menu bar
Themenu bar in the Network View includes four menus: File, Device, View and Help.

File
n Load Preset (Ctrl+L): loads a configuration from a file

n Save Preset (Ctrl+S): saves configuration for currently displayed devices to a file

n Exit (Alt+F4): Exits Dante Controller

See Presets for more information.
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Device
n Refresh (F5): Refreshes the displayed network / device data

n Device View (Ctrl+D): Opens a new Device View window

View
Allows the activation of channel groups.

Help
n About: Shows the Dante Controller version, and current event log file location

n License: Displays the license text

n Contents (Shift+F1): Opens a help window and displays help contents

Tool bar
Below themenu bar there is a tool bar, containing six buttons:

Reload Device Information Updates the current view with the latest device information from
the network. This is useful when a recent change to the network
has not yet propagated automatically through to Dante Controller
(for example, a new device has been added to the network).

Load Preset Loads a previously saved audio routing configuration. See Presets
for more information.

Save Preset Saves the current audio routing configuration. See Presets for
more information.

Choose a Dante Interface Opens the Configure Dante Interfaces dialog. See Configuring
Dante Controller for more information.

Clock Status Monitoring Activates the Clock Status Monitoring function. See Clock Status
Monitoring for more information.

Channel Groups Activates channel groups. See Channel Groups for more
information.

To the right of the toolbar, Dante Controller displays the current master clock (or clocks, in the case of
redundant networks).

Tabs
Click the tabs below the tool bar to view:

n Routing

n Device Info

n Clock Status

n Network Status

n Events

The use of each of these tabs is described in the next section.
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Status Bar
The Status Bar displays notifications for network status, general device events, and clock status events,
plus the current Dante audiomulticast bandwidth on the network.

StatusBar

The Status Bar displays the following information:

n P: The current status of the Primary network. Green indicates that Dante Controller is currently con-
nected to the primary Dante network. Red indicates a problem with the connection.

n S: The current status of the Secondary Dante network. Only displayed where a secondary network is
connected.

n Multicast Bandwidth: The current Dante audiomulticast bandwidth on the connected networks.
Note that theremay be network traffic from other sources that is not included in themulticast band-
width reading.

n Event Log: Indicates the current status of the event log. Click the icon to open the Events View.

n Clock Status Monitor: Indicates the current status of the Clock Status Monitor. Click the icon to
open the Clock Status Monitor.

NetworkView Tabs

Routing View
WhenDante Controller is started, it always displays the Routing Tab within the Network View. In this view
the network is shown in the form of a grid. Devices with Tx channels are displayed along the top row of the
grid, and those with Rx channels are displayed along the left-hand column of the grid. Initially a collapsed
view is presented; individual channels cannot be seen.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an
error condition. Double-click the device name to seemore information. Refer to Automatic
Notification of Device Errors for further explanation.

Note: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also
along the left-hand edge.
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Expanding the Routing View

The Rx channels associated with any device can be displayed by clicking on the [+] to the left of the
device name in the left-hand column of the grid. The Tx channels associated with any device can be
displayed by clicking on the [+] above the device name on the top row of the grid. When this action is
performed the grid view expands to show each channel of the device, and the [+] becomes a [-]. Clicking
on [-] collapses the view. You can also group channels into sets of 16.

The Rx channels associated with all devices can be simultaneously expanded by clicking on the [+] of “[+]
[-] Dante Receivers” at the top of the left-hand column. Similarly, the Tx channels associated with all
devices can be simultaneously expanded by clicking on the [+] of “[+] [-] Dante Transmitters” at the left of
the top row. Clicking on [-] will collapse the view.

Device List Filtering
The device lists in the Routing view can be filtered using the 'Filter Transmitters' and 'Filter Receivers'
boxes, below the Dante logo in the top left-hand corner. Any text string typed into the box will filter the view
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to only display devices that contain that text string, in either a device name, or channel name.

The filtering is case-insensitive. For example, in the Dante Controller Network view shown here, entering
the string “foh” in either of the Filter fields would display only the FOH-Amp and FOH-Console devices, and
their channels.

Channel Groups
WhenChannel Groups is active, device channels in the Network View Routing tab are grouped into sets of
16.

This makes it easier to view andmake channel subscriptions for devices with large numbers of channels,
such as PCIe cards.

To activate it, click the Channel Groups button in the Network view toolbar:

The groups are named 1..16, 17..32 etc.
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To expand a channel group, click the plus [+] icon. To collapse a channel group, click theminus [-] icon.

Note: Grouping channels does not affect routing or device behaviour.

Device Info

The Device Info tab provides a network-wide overview of device configuration and operating information.

The tabular view presents the following information, in columns from the left:

n Device Name: The device name currently associated with the device

n Product Type: The type of Dantemodule in the device
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n Product Version: The product version, as defined by themanufacturer

n Primary Address: The IP address assigned to the primary interface.
IP addresses are currently assigned via DHCP, or automatically self-assigned. Self-assigned
addresses on the primary interface will be in the 169.254.*.* range.

n Primary Link Speed: The Ethernet link speed of the primary interface

n Secondary Address: The IP address assigned to the secondary interface.
Self-assigned addresses on the secondary interface will be in the 172.31.*.* range. 'N/A' indicates
that the device does not support a secondary interface. 'Link down' indicates that the device sup-
ports a secondary Dante interface, but it is not currently connected.

n Secondary Link Speed: The Ethernet link speed of the secondary interface. Other values are pos-
sible (as per Secondary Address)

Note: A Dante interfacemay have a preferred link speed. Where it does, and an interface is not
operating at that preferred link speed, the values in the Link Speed columns will be shown in red.

Note: If no device information is displayed for a device, it can indicate a ConMon (Dante control and
monitoring service) failure on the device. The devicemay need to be reset or restored.

Clock Status

The Clock Status tab provides a network-wide overview of the clocking state within the network.

This view provides a convenient way of quickly scanning the network for clock information. The tabular
view presents the following information, in columns from the left:

Device Name
The device name currently associated with the device.

Sync
Indicates the clock sync status for the device.
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n A green light indicates that the device is currently synced to (or is driving) the network clock

n A red light indicates that the device is not currently synced

Mute
Indicates themute status for the device.

n A redmute icon indicates that the device is currently muted (usually due to loss of clock sync)

n No icon in themute columnmeans that the device is not muted (audio should be flowing normally)

Clock Source
Indicates the clock source for the device.

n Dante: The device is deriving its clock from the Dante network, or is acting as master clock (but not
deriving its clock from an external source)

n External: The device is deriving its clock from an external word clock source

Primary Status | Secondary Status
Indicates the state of the PTP clock for the primary and secondary network interfaces.

n Master: Device is the current PTP Master Clock on the primary Dante network

n Slave: Device is a PTP Slave on the primary Dante network

n Passive: Device is not using clock synchronization information from this interface

n Link Down: The interface is not connected to the network

n N/A: Indicates that the device does not support clock status reporting. In the Secondary Status
column, can also indicate that the device is non-redundant.

n Listening: Usually transient. When persistent, it indicates that the device can not operate as a clock
master (slave only), and is waiting for a clock master to appear on the network.

Devices that are configured with sample rate pull-up/down are shownwith the relevant pull-up/down value
against their Clock Status. For example, a device acting as master clock with +0.1% pull-up will be shown
as Master (+0.1%). See About Clock Domains for more information.

Other transient clock states exist, which are not listed above.

AES67 Status
Indicates the state of the PTPv2 clock for AES67-enabled devices. Possible states are identical to those
of Primary and Secondary Status.

Preferred Master
Raises the priority of the device in themaster clock election.

If only one device on a particular clock domain has this checkbox ticked, it ensures that the selected
device becomes master clock (for that clock domain). Whenmultiple devices have their PreferredMaster
checkbox ticked, themaster will be elected automatically from within that group.

If 'Slave Only' is shown instead of a checkbox, it indicates that the device is not capable of acting as a
master clock.

Enable Sync To External
Forces the Dantemodule to derive its clock from an external source - either from a host device word clock,
or from an auxiliary device.
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This will also ensure that this Dante device becomes master clock for the relevant clock domain (unless
another device has 'PreferredMaster' selected). It is not normal practice to configuremore than one device
per clock domain with an external clock source. In this case, the user is assumed to have synchronized
external word clock sources (e.g. house clock).

Where the checkbox is present but greyed-out (and inactive), it means that the Dante device can be slaved
to an external word clock, but it cannot be set directly from Dante Controller - it must be done via the host
device user interface, or via some other method (e.g. third-party control software). If the checkbox is
greyed out and populated, it means that the Dante device is currently slaved to the external clock.

If N/A is displayed, it means that the device does not support slaving to an external word clock.

Note: If no clock status information is displayed for a particular device, it can indicate a ConMon
(Dante control andmonitoring service) failure on the device. The devicemay need to be reset or
restored.

About Clock Domains
Dante Devices that are not configured with sample rate pull-up/down operate on the default clock domain,
using the default clock. Devices that are configured with sample rate pull-up/down operate on separate
'clock domains', which have their own dedicated PTP clocks, adjusted to account for the pulled up/down
sample rates.

Clock domains are not physically separated, they all exist on the network simultaneously. Devices with
pull-up/down synchronise to the appropriate clock for their pull-up/down setting, and ignore other clocks.
Those devices are shownwith the relevant pull-up/down value against their Clock Status in the Clock
Status tab.

Dante devices can only transmit audio to, and receive audio from other devices on the same clock domain.
For example, a device with zero sample rate pull-up/down operates on the default clock domain, and
cannot transmit audio to, or receive audio from any devices on the +4.1667% clock domain, or the -1%
clock domain, etc.

Up to 5 separate clock domains can be supported at any one time. All clock domains have their own
master clock.

About Master Clocks
The Dante network master clock (often also referred to as the 'GrandMaster'), is displayed at all times in
the center of the toolbar of the Network View. This is the device that is providing the time sync source for
all devices on the network.

If multiple clock domains are in use, themaster clock for each domain is shown, in a comma-separated
list.

Themaster clock is chosen automatically through an election process, though there are user configurable
parameters that allow prioritization of some devices in themaster clock election. Configuring a device to
have an external word clock source will force that device to becomemaster clock, unless another device
has 'PreferredMaster' set.

Checking the 'PreferredMaster' flag will always result in that device (or the device with the lowest MAC
address, if more than one device has been checked) becomingmaster clock for that domain.

Note: If themaster clock device is not directly visible to Dante Controller (for example, if themaster
clock device is for some reason only connected to the secondary network, and Dante Controller is
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only connected to the primary network), the 'Master Clock' display in the toolbar may show a
MAC address string, instead of the device name.

ClockStatusMonitoring
Dante devices aremonitored by Dante Controller to establish the status of their clock synchronization with
the Dante network master clock.

There are two levels of monitoring: 'passive' and 'active'.

In passivemode, Dante Controller will report if a clock loses sync (or regains sync) with themaster clock.

In activemode, Dante Controller will also report if a clock is showing signs of instability. If a device clock
is significantly unstable, it can lose sync with themaster clock, which will result in the device being
automatically muted.

Why would a device clock be unstable?
There are a range of network conditions that can interfere with a device’s clock stability. These include:

n A switch on the network is configured to use Energy Efficient Ethernet ('Green Ethernet') func-
tionality

n A 100Mb switch or link is present where aGigabit connection is required

n One ormore switches are incorrectly configured

n A 'problematic' external word clock is being used as themaster clock

Refer to the Dante FAQs for more information.

Passive monitoring
Passivemonitoring is on all the time. If a Dante device loses sync with themaster clock, or regains sync
with themaster clock, it reports the event to Dante Controller. Dante Controller records these events in a
log file, and also will display an alert: the Clock Status Monitor icon (at the bottom right corner of themain
window) will light up red.

Clicking the icon opens the Clock Status Monitor, which includes the clock status event log, and a clock
status histogram.

Active Monitoring
When activemonitoring is switched on, Dante Controller begins actively monitoring the behaviour of
supported devices to identify signs of clock instability. If a clock exhibits significant instability, the Clock
Status Monitor icon will light up amber, and a warning event will be recorded in the clock status event log.

http://dev.audinate.com/kb/webhelp#dante_controller/dante_controller_displayed_a__clock_instability_detected__popup___why_is_this.htm
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Click the icon to open the Clock Status Monitor.

Activemonitoring is off by default. To activate it, click the Clock Status Monitoring button on themain

toolbar:

When Active Clock Status Monitoring is active, the button is shown in green.

To switch it off, click the button again.

Note: Activemonitoring does not affect passivemonitoring.

Which devices are supported?
Dante PCIe cards, Dante-MY16-AUD cards, Ultimo (low channel count) devices and devices that include
a 'Brooklyn II' Dantemodule support activemonitoring.

If your device is a Brooklyn II device, it will be displayed as theModel type in the Dante Information
section of the Device View > Status tab.

ClockStatusMonitor
The Clock Status Monitor includes two tabs, Log and History.

Log
The Clock Status log shows time-stamped clock status events for each device that has been identified as
unstable, or has lost or regained sync with themaster clock.
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The event types are:

n Clock Sync Warning: Indicates that a clock has been identified as unstable, and is at risk of losing
sync with themaster clock

n Clock Sync Unlocked: Indicates that a device has lost sync with themaster clock. This will result
in the device being automatically muted until it regains sync.

n Clock Sync Locked: Indicates that a device has regained sync with themaster clock.

To delete all Clock Status log entries, click Clear . This will reset the Clock Status Monitor icon to green.

Note: This will also clear all other event log entries (the Clock Status log is a filtered view of themain
event log).

Dante Controller will then resumemonitoring (unless the Clock Status Monitoring button is switched off).

To save the event log as an xml file, click Save.

History
The History tab can be used to establish the stability of device clocks. It shows a histogram of clock
frequency offset for the selected device, and the current frequency offset value, updated in real time.

The following information is also displayed:

n Mute status

n Sync status

n External word clock

n PreferredMaster status

About Clock Offset
Hardware clocks are based on a vibrating (piezoelectric) quartz crystal. All crystals are slightly different,
and vibrate at slightly different frequencies. When a device ('slave') clock wants to sync to amaster
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network clock, its frequency must be 'pulled' up or down tomatch the frequency of themaster clock. The
amount that the clock's frequency is pulled is referred to as 'offset'.

Hardware clocks can only support a certain amount of offset, referred to as 'pull range'. If the pull range is
exceeded, the slave clock will lose sync with themaster clock, and the device will be automatically muted.

Software clocks typically use an algorithm to derive a clock from an internal counter. Software clocks can
support any amount of offset.

Rapidly-changing offset can also cause a slave clock to lose sync with themaster clock.

Various factors can destabilise slave clocks by affecting their offset, such as:

n Overloaded network links

n Poorly-implemented EEE (Energy Efficient Ethernet)

n A master clock that is derived from an inaccurate external word clock (one that does not run at its
nominal frequency)

About the Histogram
The horizontal axis of the histogram shows the distribution of clock frequency offset measurements
against the nominal frequency of the clock, in parts per million (ppm). The zero point of the horizontal axis
corresponds to the clock's nominal frequency (i.e. the frequency that the clock is intended to run at - for
example, 98kHz).

The vertical axis shows the number of measurements recorded at each data point, on a logarithmic scale.

The histogram is continually updated, with measurements taken roughly once per second.

n To select devices, click the drop-downmenu at the top .

n To clear the histogram, click Clear.

n To save a png format screenshot of the current data, click Save.

Interpreting the Histogram
The histogram can be seen as an indication of how much work a slave clock is doing to stay in sync with
themaster clock.
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Generally, a stable and accurate clock will show consistently stable offset (with variation in the order of a
few ppm). It means that it is not having to change its offset very much to stay in sync.

Show me

A histogram that shows a distributed range of offsets indicates an unstable clock - it is having to change its
offset significantly, and often, to stay in sync with themaster clock. This can be due to overloaded network
links, or poorly-implemented EEE. A device in this state is highly likely to lose sync with themaster clock.

Show me

A histogram that shows measurements in amber and/or red indicates a clock that might be currently
stable, but has little room for manoeuvre; its offset could easily move outside its pull range, at which point
it will lose sync completely. This can result when themaster clock is derived from an inaccurate external
word clock.

Note: Dante Controller can be left running for a few days (or even weeks) to collect clock status
data, providing a long-term picture of the stability of your network clocking configuration.

Show me
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Network Status

The Network Status tab provides a range of network-related information across all devices in the network.

This view includes subscription status, bandwidth and latency information, and can be used to quickly
identify any potential network traffic issues.

The tabular view presents the following information, in columns from the left:

Device Name
The device name currently associated with the device.

Subscription Status
The icon in the Subscription Status column displays a summary of subscription states for the device. If
any of the device's channels are not successfully subscribed, the relevant icon will be displayed here.

See Subscribing to Audio Channels for information about the various icons that can be displayed in the
Subscription Status column.

Primary Status
The Primary Status column indicates the link speed of the primary Dante network interface for the device.

Secondary Status
The Secondary Status column indicates the link speed and status of the secondary Dante network
interface for the device (if applicable). 'N/A' indicates that the device does not have a secondary interface.
'Link Down' indicates that the device has a secondary interface, but it is not currently connected.
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Bandwidth Columns
Use the bandwidth columns to see an approximation of transmit and receive traffic over individual device
interfaces.

n Primary Tx B/W

The Primary Tx B/W column displays an approximation of the current transmit bandwidth on the
primary Dante network interface for the device.

n Secondary Tx B/W

The Secondary Tx B/W column displays an approximation of the current transmit bandwidth on the
secondary Dante network interface for the device.

n Primary Rx B/W

The Primary Rx B/W column displays an approximation of the current receive bandwidth on the
primary Dante network interface for the device.

n Secondary Rx B/W

The Secondary Rx B/W column displays an approximation of the current receive bandwidth on the
secondary Dante network interface for the device.

Latency Setting
Shows the current latency setting for the device.

Latency Errors
The Latency Errors column displays icons representing the recent latency performance of the device.

A green light indicates that the device is subscribed, and there are no latency problems - i.e. all
audio packets are arriving well within the device's latency setting.

An amber light indicates that audio packets for one or more channels are arriving at or near the
limit of the device's latency setting. Youmay need to increase the device's latency, or reconfigure
the network to prevent audio glitches due to packet loss from late-arriving audio packets.

A red light indicates that one or more audio packets have arrived outside the device's latency
setting. This will result in audio glitches. The device's latency setting should be increased, or the
network reconfigured (for example, by reducing the number of network nodes in between the
transmitter and the receiver).

A grey light indicates that the device is not currently subscribed.

Packet Errors
A red light in the Packet Errors column indicates that one or more audio packets have been corrupted in
between the switch and the receiver. This is usually due to a faulty Ethernet cable.

Use the Clear Counters button in the Device View > Status tab to clear the packet errors history for a
device.
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Events

The Events tab provides information on significant changes and failures in the network.

Dante Controller continually monitors Dante devices and the network as a whole. It is able to watch for
problematic configurations, unexpected problems and communication failures between itself and Dante
network devices. Events are displayed and stored in an event log.

Events fall into one of three categories: Information, Warning and Error.

Filtering the Event List
Use the drop-downmenu at the bottom left of the view to filter the events list.

n When set to Information, all events are shown.

n When set toWarning, only warning and error events are shown.

n When set to Error, only error events are shown.

Clearing the Event List
To clear the event list, click the Clear button. When new events are detected that match the current filter
setting, they are displayed in the event list.

If you have switched to another Network View tab, new events in the event list will also be indicated by a
red Event Log LED icon in the Status Bar. Clicking the LED icon will take you straight to the Events tab
and will clear the Event Log LED.
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Note: The Event Log LED icon will always remain green while the Events tab is open.

Saving the Event Log
To save the event list, click the Save button. The list is saved as a text file with file extension .log. All
events in the list are saved (the filter does not apply to saved events logs).

Automatic event logging
Events are also continuously written to a log file. Each time Dante Controller is started, it creates a new log
file (with a time-stamped filename, to avoid overwriting previous logs).

You can find the path to these log files under Help > About. To delete log files more than seven days old,
click the Delete old Log files button.

Event Classification
The following events are classified as Errors:

n Invalid link local address

n Subnet mismatch on dante interface

n Subnet match with non dante interface

n Multiple addresses with matching subnets

n Subnet conflict of dante interface on primary

n Subnet conflict of dante interface on secondary

n Unknown address error

n Fail SafeMode

n Unknown device issue

n Elevation to Clock Master

n Fanout Configuration detected

n Mismatched clock pullup subdomain

n Wrong subdomain for pullup

n Unknown subdomain

n Audiomute / Audio unmute

n Clock sync lock / unlocked

The following events are classified as Warnings:

n Resolution Failed

n Elevation to GrandMaster

n Multiple external clock sources

n Cannot Elevate to Clock Master

n Clock Sync Warning

The following events are classified as Information:

n Request Timeout Error

n Response Timeout Error

n Demotion from Clock Master
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n Demotion from GrandMaster

n Reboot required

AutomaticNotification of Device Errors
Dante Controller is able to identify several types of problems that a Dante devicemay experience. A
device that is found to have problems will have its device name displayed in red. Additional information
about the problem can be found by double-clicking on the device.

A device displayed in red will either have entered failsafe mode, or will have an identified issue with its IP
configuration. These states are described inmore detail below.

A device displayed in orange (’Ultimo’ low channel count devices only) will have entered upgrade mode
(see below).

Incorrect IP address configuration
Dante networks use IP Addressing to communicate. Incorrect address configuration canmake it hard or
impossible for a Dante device to communicate. Dante Controller attempts to identify and report several
types of incorrect IP address configuration, including:

n Havingmultiple DHCP servers on the same network

n Incorrectly configured static IP addresses

n Connecting the secondary interface of a Dante device to the primary network

n Different interfaces on the same device using the same IP address subnet

n Configuring a DHCP server on the primary network to use the IP address range reserved for sec-
ondary link local devices (172.31.*.*)

If you need further information, please refer to the Troubleshooting section.

Failsafe mode
A device will enter failsafe mode when the firmware image stored on the board has become corrupted.
Although rare, this can occur when:

n The firmware update process is interrupted by power loss or network failure

n The firmware image itself that was used in an upgrade is corrupt

If your device enters failsafe mode, please use the Failsafe Recovery function in the Firmware Update
Manager application (if available) or contact your devicemanufacturer.

Upgrade mode
When some ‘Ultimo’ devices (technically, those that include an internal Ethernet switch) are upgrading, or
have finished upgrading but have not yet been rebooted, they are in ‘upgrademode’, and are displayed in
orange text in Dante Controller. While in this mode, an ‘Issues’ tab is visible in the Device View for the
device, indicating their current state.

When these devices have had new firmware applied, they must be ‘manually’ rebooted by the user, via
Dante Controller (unlike other devices which reboot automatically as part of the upgrade process). This is
because any daisy-chained Dante devices downstream of the upgraded device will not receive audio or
firmware update data via that device while it is rebooting. Themanual reboot option allows you to control
when the device reboots, and thus prevent:
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n Interruption of audio to any downstream daisy-chained devices until it is convenient, and

n Interruption of firmware update data to any downstream daisy-chained devices that are also in the
process of updating - which in some devices can lead to the update failing, and the device entering
failsafe

When the device has rebooted, audio flow to any downstream daisy-chained devices will resume
automatically.

Other Event Notifications
Dante Controller will also notify you of network status, general device events and clock status events, via
the LED icons in the Status Bar.

Device View
The Device View is used to view andmodify detailed information and settings for a specific device. Device
view can be activated by double-clicking a device name in any of the Network View tabs (except Events),
or by selecting Device View from the Device menu (Ctrl + D, or Command + D) in the Network View
window. The Device View opens in a new window. Multiple device views can be open simultaneously.

Note: Mac OS X users: Please note that the key combinations shown below are forWindows users.
When using Dante Controller on aMac, please use the 'Command' or 'Apple' key instead of the Ctrl
key when following the instructions below, and substitute standardMac key combinations where
applicable – see the Dante Controller menus for details.
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The label of the device being viewed is displayed in themiddle of the toolbar. In the screenshot above,
FOH-Console is the device being displayed in the drop-down list box.

The device viewed can be changed by selecting another device from the drop-down list.

Multiple Device View windows may be opened from the Network View, so that several devices can be
examined simultaneously.

The Device View displays some or all of the following tabs, allowing you to see different information
relating to a specific Dante device:

n Receive: Display and configure device’s receive (Rx) channels

n Transmit: Display and configure device’s transmit (Tx) channels includingmulticast

n Status: Device software, clock and network status information

n Latency: View latency histograms (supported devices only)

n Device Config: Rename device, change sample rate and set other attributes (as relevant to device
type)

n Network Config: View and edit network configuration

n Issues: Displays information for devices in failsafe mode, or upgrademode (upgrademode is used
by ‘Ultimo’ low channel count devices only). Not usually visible.

n Baseboard: Only available when the Dante device is mounted on a Dante PDK audio baseboard
(NOTE: the devicemust be in SPI Master mode)
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Device View Menu bar
Themenu bar in the Device View contains the followingmenus:

File
n CloseWindow

Device
n Refresh: Refreshes the displayed network / device data

n CreateMulticast Flow

View
n Show/Hide Channel Groups

Help
n About: Shows Dante Controller version and current log file

n License: Displays the license text

n Contents: Opens a help window and displays help contents

Device View Toolbar
The Device View toolbar contains the following buttons:

Refresh Re-load routing and configuration information for
the current device.

Web Config SomeDante devices can be configured via a web
interface. This button opens a web browser
window which can be used to perform functions
such as firmware upgrades. This feature is not
supported on all Dante devices.

Identify Identify the current device by, for example, causing
its LEDs to flash. Note that this feature is not
supported on all Dante devices.

Multicast Configuremulticast transmit flows on the current
device.

Channel
Groups

Activates / deactivates Channel Groups.

The toolbar also provides a drop down list of all available devices on the network, which allows you to
switch the Device View to a different device.

Device View Tabs
The Device View is split into tabs, some of which are only applicable to certain devices. Each tab is
described in detail below.
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Receive Tab
The Receive tab displays a list of all subscribed and dormant receive channels on the current device, plus
subscription information for the subscribed channels. It also allows the creation of subscriptions from the
Available Channels list.

The tab is split into two panes: Receive Channels, and Available Channels.

Receive Channels
The Receive Channels pane contains four fields:

n Channel: Lists the receive channel labels for the current device. These can be edited here to rename
the channel.

n Signal: Supported devices will also show the following channel metering icons, indicating the
presence of audio on subscribed channels:

Channel is either muted, or receiving audio at less than -61dbFS

Channel is receiving audio between -61dbFS and 0dfFS

Channel is clipping

Which devices support channel metering?
Currently, Brooklyn II and PCIe devices support channel metering in Dante Controller. You can check your
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device type in the Device Info tab.

n Connected To: Lists the Tx channel that the receive channel is currently subscribed to.

n Status: Shows the status of both primary and secondary subscriptions, using the following icons:

Subscription is OK and audio should be flowing

Subscription is unresolved - usually because the transmitting device
has been removed from the network, or is switched off

No subscription, or a subscription error

Subscription is via unicast connection

Subscription is via multicast connection

Subscriptions can show several symbols in the Status column. Common status icon combinations and
their meanings are as follows:

Unicast device successfully subscribed to a
transmitter

Redundant device successfully subscribed on
both primary and secondary via unicast

Redundant device successfully subscribed on
both primary and secondary via multicast

Redundant device successfully subscribed on
primary only via unicast. This is typically seen
when the secondary interface is not connected

Available Channels
The Available Channels pane lists the devices and advertised channels available on the network. Devices
that are greyed out indicate that this receiver cannot subscribe to those channels or devices. This is
typically because of amismatch in parameters (e.g. sample rate incompatibility etc.), or because a device
cannot route audio to itself.

For devices with many channels, you can click the Channel Groups button to group available
channels into sets of 16.

AES67 Flows

‘Devices’ with multicast IP address names (e.g. 239.69.82.194) are actually AES67 flows, which can only
be received (or transmitted) by AES67-enabled devices.

Note: If they are displayed in blue, the currently-selected device is AES67-enabled, and can receive
AES67 flows. If they are displayed in grey, the currently-selected device is not AES67-enabled.

Creating Subscriptions
Subscriptions are created by selecting a channel from the Available Channels list in the right-hand pane of
the Receive Tab, then dragging and dropping it onto the appropriate receive channel in the left-hand pane of
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the Receive Tab.

Multiple channels can be selected and then dragged and dropped onto the Receive Channels pane, to
make several subscriptions simultaneously. You can also drag and drop channel groups tomake bulk
subscriptions.

Changing Receive Channel Labels
To change a receive channel label, click the label and type in the new value.

Transmit Tab
The Transmit tab is used to inspect andmodify the transmit configuration of a device.

The Transmit Tab is arranged in two areas:

n Transmit Channels: The area on the left pane of the tab shows the Tx channels for the device, and
any user-defined channel label. It allows you to create labels for transmit channels. Input to the table
is filtered to prevent illegal characters from being used in channel labels.

Supported devices will also show the following channel metering icons in the Signal column,
indicating the presence of audio on subscribed channels:

Channel is either muted, or receiving audio at less than -61dbFS

Channel is receiving audio between -61dbFS and 0dfFS

Channel is clipping
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n Transmit Flows: The area on the right pane of the tab indicates how many unicast flows are cur-
rently in use, as well as themulticast transmit flows that have been configured on the device. Mult-
icast flows are listed in ID order, including the channels contained within the flow.

Note: Unicast flow details are not displayed in the transmit flow window. The total number of
transmit flows currently in use is shown at the top of the pane. The total number of flows is the sum of
the unicast andmulticast flows in use. Themaximum number of flows that the device supports is
also shown (32 in the screenshot above).

Changing Tx channel labels
To change a Tx channel label double click on the label and type in a new one. Tx channel labels must be
unique on a single device.

Status Tab
The Status tab is used to obtain current information about a Dante device.

The tab is divided into sections. The information presented on this tab can be very useful when

investigating networking or clocking issues in the system. The Refresh button can be used to update
this information if required.

Note: Not all Dante devices support the display of all of this information.

Device Information
This provides the following general information about the device:
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n Manufacturer: The name of the devicemanufacturer.

n Product Type: The type of device.

n Product Version: The product version.

n Software Version: The version of themanufacturer software running on the device.

n Firmware Version: The version of themanufacturer firmware running on the device.

Dante Information
This provides Dante-specific information about the device:

n Model: The Dante device type.

n Software Version: The version of the Dante software running on the device.

n Firmware Version: The version of the Dante firmware running on the device.

Clock Synchronization
This provides the following information about device clocking:

n Mute Status: 'Muted' indicates that the device is has been automatically muted (due to a clock syn-
chronisation problem, or because the external word clock is invalid). 'Unmuted' indicates that the
device is not muted, and audio is flowing normally.

n Sync Status: 'Locked' indicates that the device is locked to the network PTP clock. 'Not Locked'
indicates that the interface has not achieved lock with the network PTP clock.

n External Word Clock: 'No' indicates that the device has been configured to use the internal clock
source. 'Yes' indicates that the device has been configured to accept an external word clock source.
NOTE: If the Dante device is configured to accept an external word clock source, it is important to
make sure that the host equipment has been configured to provide its word clock to the Dante
device. Check your product manual for more information.

n Preferred: 'No' indicates that the card has not been set to preferredmaster mode. 'Yes' indicates
that the card is set to preferredmaster mode.

n Frequency Offset: Indicates the offset from the network clock master measured in parts-per-billion.

Primary Interface
Provides the following information about the primary network interface:

n IP address: The IP address currently assigned to the interface

n MAC address: TheMedia Access Control address of the interface, associated with the Ethernet
layer

n Tx Utilization: Shows the current total transmit bandwidth in use

n Errors: (on the same line as Tx utilization) shows the number of transmit Cyclic Redundancy Check
(CRC) or packet errors detected since the device was last started

n Rx Utilization: Shows the current total receive bandwidth is use

n Errors: (on the same line as Rx utilization) shows the number of receive Cyclic Redundancy Check
(CRC) or packet errors detected since the device was last started

Note: The Rx Utilization includes not only network traffic destined for the Dante device, but any
other multicast or broadcast traffic received at this network interface.
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Note: As a rule of thumb neither the Rx nor the Tx utilization should exceed about 85% of the link
speed in order to guarantee good clock synchronization performance (links are full duplex).

The graphic also indicates the speed and connected state of the interface as follows:

Indicates that the link is operating at 1Gbps

Indicates that the link is operating at 100Mbps

Indicates that the link is not connected, or that there is an error.
The IP address will read N/A, and Tx and Rx utilization will be 0
kbps.

Clear Counters: Click this button to reset the packet errors history for the device.

Secondary Interface
This provides the same information for the secondary interface that is provided for the primary interface, as
described above.

Note: The secondary network interface will only be displayed if the device supports redundancy.

LatencyTab
For supported devices, the Latency tab displays histograms of audio packet latency for each transmitter
that the device is subscribed to.

Which devices support latency monitoring?
Newer Brooklyn II, PCIe and Ultimo devices support latency monitoring in Dante Controller. You can
check your device type in the Device Info tab.

About Latency and Packet Loss
Latency is used to account for the delay between an audio packet leaving the transmitter, traversing the
network (potentially throughmultiple switches) and reaching the receiver.

If a receiver's latency setting is too low, audio packets will not have time to get from the transmitter to the
receiver before they are supposed to be played out. When this happens, the receiver will drop packets (i.e.
it will throw packets away, because they are 'late to the party').

Packet loss results in audio glitches, so it is very important to ensure that all receivers have their latency
set high enough to prevent packet loss.
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Setting device latency too high, however, can interfere with low-latency applications (for example, real-
timemonitoring when recording vocals), so it is sometimes important to find a balance between low
latency and guaranteed audio integrity.

The Latency tab can be used to identify:

n Devices that are dropping packets because their latency is set too low

n Devices that are at risk of dropping packets because their latency is set too low

n Devices that could potentially have their latency reduced (if required; generally, the default Dante
latency of 1ms is more than adequate for low-latency applications)

About the Histogram
The transmitter's name is displayed at the top of the histogram, along with the latency value against which
the histogram is reporting.

The horizontal axis shows the distribution of audio packet latency measurements from the transmitter. The
vertical axis shows the number of measurements recorded at each data point, on a logarithmic scale.

Measurements are taken at roughly 1 second intervals, from when Dante Controller is started.

To clear the histogram, click Clear. Latency measuring will then restart.

To save the histogram as a png image, click Save.

Note: If any subscriptions are via multicast flows, theremay be two histograms displayed for one
transmitter: one histogram for the unicast flows, and one for multicast. This is becausemulticast
flows always use a latency of 1ms. If the receiver is set to a latency other than 1ms, two histograms
will be displayed.

The following information is also displayed:

n The latency Setting for the histogram. Inmost cases, this will be the same as the latency setting on
the receiver. However, for some subscriptions, Dante will automatically apply a different latency. For
example:

o Multicast flows are automatically set to aminimum of 1ms

o If a transmitter does not support the latency set on the receiver (i.e. it can't guarantee delivery
within the required latency), Dante will increase the latency to the lowest setting supported by
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the transmitter. Ultimo devices, for example, support a minimum latency of 2ms, so sub-
scriptions to Ultimo devices will use aminimum of 2ms latency.

n The Peak latency sincemeasuring started

n The Average latency sincemeasuring started

n The number of measurements taken that included one or more Late packets (note that eachmeas-
urement typically includes many packets)

Interpreting the Histogram
If all bars are green and falling well within the limit of the histogram (i.e. towards the left or middle of the
histogram), it indicates that the latency setting for the receiver is set high enough to prevent packet loss.

Show me

If any bars are amber, it means that some packets are arriving near the limit of the latency setting. Network
traffic fluctuations could potentially lead to extra delay which could cause packets to arrive late. A
histogram of this type indicates that the receiver latency should be increased if possible.

Show me
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If any bars are red, it indicates lost packets, and audio loss. The receiver latency should be increased, or
the network reconfigured.

Note: Dante Controller can be left running for a few days to collect latency data, providing a long-
term picture of the latency performance of your network configuration. This is especially useful after
any network infrastructure upgrades, or after the addition of more end point load in a given network, to
determine if QoS tuning or increased capacity may be required at the network switch level.

Show me
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Device Config Tab
This tab on the device view window allows you to configure device specific parameters. The specific
options available will depend on the capabilities of the device. In the case where a device does not support
configuration via Dante Controller, the tab will be disabled.

Note: Dante Virtual Soundcard does not have a Config Tab available on Dante Controller. The Dante
Virtual Soundcard User Interface on the PC orMac must be used to configure these devices.

Configurable Parameters

Rename Device
Allows you to enter a new Dante 'friendly name' for the device. The text field displays the current name.

To change the device name, enter a new name in the text field and press Enter.

See Device Names and Channel Labels for information about name conflicts and device name rules.

Sample Rate
n Shows the current sample rate of the device, and allows you to change the operating sample rate of

the Dante device. This may require the device to be rebooted to take effect. All sample rates sup-
ported by the device are shown in the drop downmenu.



Dante Controller User Guide

Copyright © 2015 Audinate Pty Ltd. All rights reserved. -63-

n Shows the current pull-up/down setting for the device, and allows you to change the pull-up/down set-
ting. The pull-up/down setting can be used to adjust the sample rate of the device to synchronise
audio with video that has undergone frame rate conversion. For example, to synchronise Dante audio
with video that has been converted from 24 fps to 25 fps, set the sample rate pull-up/down for any rel-
evant Dante audio devices to +4.1667%.

Note: Changing the sample rate pull-up/down for a device places that device in a dedicated clock
domain. Dante devices can only transmit audio to, or receive audio from other devices on the same
clock domain. See Clock Status View for more information.

Device Latency
Shows the current device latency setting, and allows you to change the operating receive latency for the
selected device. Select a value and click OK to apply the latency to all flows that the device is receiving.

Note: The 150 µsec setting is unavailable for devices that include an internal network switch.

Note: Device latency cannot be configured for Dante Via devices.

Warning: Changing the latency value will cause disruption in the audio while the flows are re-
established at the new latency setting.

Reset Device
Allows you to remotely reboot the Dante interface, and also to reapply factory settings (Factory Reset).
Rebooting the Dante devicemay also require a reset of the host audio equipment containing the device.

Factory Reset wipes the following device configuration settings:

n User-defined device name

n User-defined channel labels

n Clock configuration (clock master / external clock master setting)

n Static IP addresses

n Redundancy configuration

n Sample rate setting (including pull-up/down)

n Latency setting

n Any existing audio routes

Supported devices allow you to 'Clear Config' instead of Factory Reset. Clear Config wipes the same
configuration settings listed above, but allows you to optionally keep the IP settings (i.e. retain the Dante
Redundancy settings, and any static IP addresses currently configured in the Network Config tab).

A reboot is required after clearing the configuration for the changes to take effect. Some devices will allow
you to automatically reboot after clearing the configuration. If this option is not available, amanual reboot is
required.
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NetworkConfig Tab
Use the Network Config Tab to toggle supported devices between Redundant and Switchedmodes, and to
specify static IP addresses for a device's Ethernet ports.

Dante Redundancy / Switch Configuration
Depending on themanufacturer's configuration of a device, it may be possible to toggle the device
between Redundant and Switchedmodes, or to select a Switch Configuration.

Redundant
When a device is set to Redundant, the device will duplicate Dante audio traffic to both Ethernet ports,
allowing the implementation of a redundant network via the secondary port. Not all devices support
redundancy.
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Switched
When a device is set to Switched, the secondary Ethernet port will behave as a standard switch port,
allowing daisy-chaining through the device.

Switch Configuration
Certain devices support specialist switching and/or redundancy configurations for the Ethernet ports. For
these devices, the top pane of the Network Config tab will be titled 'Switch Configuration'. Please refer to
themanufacturer's technical documentation for information on the supported switching configurations for
the device.

Addresses
Dante devices obtain IP addresses automatically by default, and in the vast majority of circumstances
there is no need to change the Addresses settings. However, static IP addresses can be assigned if
necessary.

To assign a static IP address:

1. Select 'manually configure an IP Address' for the appropriate Ethernet port.

2. Enter the IP Address and Netmask.

3. Click Apply.

The DNS Server andGateway settings are optional - the device will use network defaults if they are not
specified.

Click Revert to revert back to the previous settings.

Note: Assigning static IP addresses requires a device reboot.

AES67Config
For supported devices (Brooklyn II v3.9.x devices and up), the Device View also includes an AES67
Config tab. The AES67Config tab allows the selection of AES67mode for the device.
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AES67 is a standard for audio over IP interoperability.

Devices in AES67mode are able to transmit and receive AES67multicast flows to / from other AES67-
enabled devices.

AES67 Mode
Select Enabled to enable AES67mode for the device.

Use the CreateMulticast Flow panel to create AES67 flows.

Tx Multicast Address Prefix
You can use the Tx Multicast Address Prefix field to specify amulticast subnet, for cases where device(s)
on your Dante network are fixed to a particular address range.

Note: Presets do not support AES67 flows.

HARemote
For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View also includes an
HA Remote tab. The HA Remote tab allows the selection of the HA Remote bridgingmode for the device.
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HA Remote is a proprietary serial control protocol used by Yamaha products. For more information about
HA Remote bridgingmodes, please download the latest version of the Dante-MY16-AUD user guide from
the Yamaha website.

Avid Config Tab
For supported devices (DNT-192 expansion cards), the Device View also includes an Avid Config tab.

The Avid Config tab allows the configuration of the DNT-192 card, and displays relevant firmware and
hardware version information.
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The tab includes 3 sections:

n Avid Dante Card Information: Displays information about card hardware and software versions

n Avid Rack Status Information: Displays information about the rack status for the card

n Avid Dante Card Control: Allows the configuration of various DNT-192 settings

Avid Dante Card Information
This section displays:

Application version
The version of the Dante application currently installed on the DNT-192 card.

FPGA Version
The version of the FPGA binary on the card.

Board Version
The hardware version of the card.

Avid Rack Status Information
This section displays:
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Rack Sample Rate
The sample rate at which the rack is currently set to.

Rack Mute Status
Themute status of the rack.

Avid Dante card Control
This section allows high-level configuration of the DNT-192 card.

Card Configuration
In ‘Dante’ mode the card configuration is automatically set by the rack. In ‘Generic’ mode the configuration
is manually selectable.

The Card Configuration option supports 3 values:

n Input card: The card functions as a 16-channel input device

n Output card: The card functions as a 16-channel output device

n Input/Output card: The card functions as an 8-in + 8-out device

SRC
Sample Rate Conversion.

When enabled, the card will convert incoming (Rx) audio to the Rack Sample Rate (if required), and
outgoing (Tx) audio to the sample rate of the receiving device on the Dante network (if required).

Note that SRC adds latency of roughly 1.3ms to the Dante subscription in each direction.

Card Identity
n Dante: The card will identify itself as a Dante device to the host device rack, enabling Dante func-

tionality on the host device. Required for Dante-enabled host equipment.

n Generic: The card will identify itself as a generic digital audio interface (required for non-Dante host
equipment).

Multicast Transmit FlowConfiguration
Click theMulticast Configuration button in the Device View to open the Create Multicast Flow dialog.
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The window shows a list of the Tx channels for the device, and allows you to add them to the new
multicast flow that is being created, by checking the tick box next to each channel name. Once you have
selected all the channels required, create themulticast flow by clicking the Create button at the bottom of
the dialog box. To abandon creating a new multicast flow, click Cancel.

A single multicast flow can contain up to themaximum supported channels per flow for this device. This is
displayed at the top of this window, and is 8 channels for this device. If you select more than themaximum
allowed channels per flow, multiple flows will be created.

Once a flow has been created, it will appear in the list of flows in the transmit pane, along with the channels
contained within that flow. Channels cannot be added to or removed from existing flows. Each time the
dialog is used to select additional channels, a new multicast flow will be created.

By default, Dante receivers will connect to amulticast flow if one exists that contains the required channel
(s), rather than creating a new unicast flow.

If a channel that does not form part of an existingmulticast flow is added to a new multicast flow, any
existing unicast subscriptions to that channel will automatically switch over to use the new multicast flow.

Care should be taken when deleting amulticast flow, as the existing subscriptions will convert back to
unicast. This has the potential to result in exceeding the link capacity or maximum number of flows at the
transmit device, as multiple unicast flows will be established between the transmitter and its receivers. It
may be advisable to remove some or all of the audio routes prior to deleting themulticast flow.

A good rule of thumb is to usemulticast when there aremore than two receivers for a specific audio
channel. You should also assume that the flow will flood throughout the entire network, and therefore
consume bandwidth on all network links.
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Note: Certain Ethernet switches support IGMP (Internet GroupManagement Protocol), a protocol
that provides the ability to 'prune' multicast traffic, so that it travels only to those end destinations that
require that traffic. If this is the case, and IGMP is correctly configured on all the Ethernet switches,
thenmulticast audio will not flood throughout the network, but will instead be sent only over the links
required to deliver it to subscribed devices.

AES67 Flow
The AES67 Flow option is only available for AES67-enabled devices.

When AES67 Flow is checked, the selected channels will be added to an AES67 flow. Only AES67-
enabled devices can receive AES67 flows.

AES67 flows appear in blue at the far right of the Routing tab of the Network View, and at the bottom of the
Available Channels list in the Device View receive tab. AES67 flows are identified by their transmit
multicast IP addresses, rather than device names.

For AES67 devices, each device transmit channel can simultaneously support an AES67multicast flow
and a standard Dantemulticast flow.
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Presets
Dante Controller supports the saving and loading of Dante network routing and device configurations,
known as 'presets'. A preset file contains configuration and routing parameters for some or all of the
devices in the network.

Preset files are saved as xml, and can be edited offline. They are also 'device-agnostic' - they can be
shared between networks with different physical devices.

You can use presets to:

n Backup and restore network configurations

n Quickly switch between saved network configurations

n Copy a Dante network configuration from a 'lab' or test network to a live or production network

n Create network configurations for special, or periodic events, and then switch back to the standard
configuration when desired

n Quickly apply one or more configuration settings to a number of devices simultaneously - for
example, setting all devices on your network to the same sample rate (global configuration)

n UseDante Controller as an off-line editing tool – off-line edit the saved preset configuration for reuse
in new network configuration deployments

About Device Roles
Presets introduce the concept of 'device roles'. When a preset is saved, the configuration and routing for
each selected device is saved into the preset as a device role, with the same name as the device from
which it was created.

The role is not 'tied' to its originating device. When a preset is loaded into Dante Controller, each role can
be applied to its originating device, or to another device (even if it does not support exactly the same
functionality). It is a transferable set of device configuration and routing parameters.

For example:

Dave the sound engineer has gigs on Friday and Saturday night at a local venue. On Friday
evening before the gig, he sets up his Dante network at the venue, and when he's happy with it, he
saves the preset.

After the gig, Dave's annoying boss turns up and steals themixing console for another job. Dave,
however, has a friend with a similar console (conveniently from the samemanufacturer, and with a
higher channel count) which he can borrow for Saturday's gig.

The next night, Dave simply connects the new mixing console to the network, in place of the old
one, and reloads his preset. The new console is now configured exactly like the old one - including
all of the relevant channel labels, and audio subscriptions - and the network functions exactly as
before, without any need for further configuration. The gig goes really well, and the band takes
Dave out for dinner.

If a role is applied to a device that is different from the role's originating device - for example, a role for
consolemodel A is applied to consolemodel B - Dante Controller will identify any issues that might arise



Dante Controller User Guide

Copyright © 2015 Audinate Pty Ltd. All rights reserved. -73-

(such as unsupported sample rates) and will display those issues so they can be addressed - or ignored, if
they are not important.

Saving Presets

To save a Preset that includes all device parameters:

1. Click the ‘Save Preset’ button in themain toolbar: 

2. Select the devices that you wish to include in the preset.

Click All to select all devices, or None to clear all selections.

3. Click Save.

To save a Preset that includes a selection of device parameters:

1. Click the ‘Save Preset’ button in themain toolbar.

2. Click Advanced.

3. Select the devices that you wish to include in the preset.

4. Select the parameters that you want to save for the selected devices.

5. Click Save.

Presets are saved as an xml files, which can bemanually edited if required, using a text editor.

Parameter Rules

Rx Subscriptions
If ‘Rx Subscriptions’ are included in the preset, and applied to the target system (i.e. ‘Rx Subscriptions’ is
checked in the Advanced > Parameters columnwhen the preset is saved, and also checked in the Preset
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Elements columnwhen the preset is applied):

All subscriptions for all matched devices on the target system will be updated tomatch the source system.
This means that:

n All subscriptions saved into the preset will overwrite the respective subscriptions for matched
devices on the target system. If the subscriptions are identical, they aremaintained.

n Any existing subscriptions on the target system that do not exist in the preset will be removed,
regardless of whether any subscriptions are defined in the preset.

Tx Flows (multicast flows)
The behaviour for TX Flows and Tx Channel Labels is different to that of Rx Subscriptions.

If ‘Tx Flows’ are included in the preset, and applied to the target system (i.e. ‘Tx Flows’ is checked in the
Advanced > Parameters columnwhen the preset is saved, and also checked in the Preset Elements
columnwhen the preset is applied):

n All Tx flows saved into the preset will overwrite the respective Tx flows for matched devices on the
target system.

n Any Tx flows on the target system that do not exist in the preset will be removed, if at least one Tx
flow is defined in the preset. Otherwise (i.e. if no Tx flows are defined in the preset), all Tx flows on
the target system aremaintained (note this is different to how Rx subscriptions are handled).

n Multicast flows and/or transmit channel names can bemanually deleted from the target device prior
to or following the preset application.

Tx Channel Labels
The behaviour for Tx channel labels is identical to the Tx flows behaviour described above.

Applying Presets
To load and apply a saved preset, select File > Load Preset from themainmenu (Ctrl + L).

Legacy preset files are supported.

The 'Apply Preset' dialogue is arranged in 4 columns, representing the logical steps in applying a preset
(from left to right).
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Preset Elements
Use the Preset Elements column to select the parameters that you wish to apply from the preset to the
target network.

If the target network is not identical to the original network (from which the preset was saved), some
elements might not be applied successfully. For example, if some devices on the target network do not
support the same range of sample rates as the devices on the original network, you could choose not to
apply the 'Device Sample Rate' element, and change the sample rates manually instead, once the preset
has been applied.

Preset Roles
The Preset Roles column lists the roles that were saved in the preset.
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You can apply a role to the same physical device from which it was created (if it exists in the target
network), or to a different device in the same network, or to another device in a new network.

When a role is applied to the same physical device, or a device of the exact samemodel, the configuration
and routing should be replicated perfectly (although some subscriptions may be 'broken', if the relevant
transmitters are not also present on the target network).

Note: This makes presets an ideal way to backup and restore configurations for relatively static
networks.

If a role is applied to a different devicemodel or a different type of device, the configuration and routingmay
not be replicated exactly - the success of the role assignment will vary depending on the functionality and
channel support of the target device.

Applying a role to a fundamentally different type of devicemay not be very successful. For example,
applying a role for a fully-subscribed 32-channel mixing console configured at 96kHz to a 2-channel
amplifier that only supports 48kHz will be problematic - only two channels can be subscribed (assuming
the transmitters are also present), and the sample rate will be rejected.

You can apply a role to multiple devices. You cannot apply multiple roles to one device.

To see which devices a role has been assigned to, click the role. The assigned device/s will be highlighted
in the 'Target Devices' column.

Automatic Assignments
Dante Controller will automatically assign roles to devices, based on the following rules:

n If there is a perfect devicematch (i.e. the physical device in the original network from which the role
was created is also found in the target network), the role is assigned automatically

n If there is a device namematch, the role is assigned automatically

n If a perfect match or a device namematch cannot bemade, the role will be assigned automatically to
a device of the samemanufacturer andmodel, assuming there is an unassigned device of that type

Removing Assignments

To remove an assignment, select the target device and click Clear or press the Delete key on your
keyboard.
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Manual Assignments
Tomanually apply a role to a device:

n Drag the role onto the device, or:

n Select the role in the 'Preset Roles' column and the target device/s in the 'Target Devices' column,
and click Apply.

The LED icons against each role indicate the assignment status of the role.

A grey icon indicates that the role has not been assigned to any target devices.

A green icon indicates that the role has been successfully assigned to one or more target devices.

An amber icon indicates that the role has been assigned to one or more target devices, but there is a
warning condition associated with one or more of the assignments.

A red icon indicates that the role has been assigned to one or more target devices, but there is an error
condition associated with one or more of the assignments.

A black icon indicates that the role has been assigned to a target device, but the assignment will have a
potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal issues
are identified.

Target Devices
The Target Devices column lists the device names of devices on the currently connected Dante network,
and the roles that have been assigned to them (if applicable).

The LED icons against each device indicate the assignment status of the device.

A grey icon indicates that the device has not been assigned a role.

A green icon indicates that the device has been successfully assigned a role.

An amber icon indicates that the device has been assigned a role, but there is a warning condition
associated with the assignment.

A red icon indicates that the device has been assigned a role, but there is an error condition associated
with of the assignment.
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A black icon indicates that the device has been assigned a role, but the assignment will have a
potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal issues
are identified.

Issues
The Issues column lists all issues identified by Dante Controller. Clicking a role or a target device will
highlight the issues associated with that role or role assignment.

The following are 'terminal' issues that could render the network unusable (identified by a black LED icon):

n You cannot apply the same device name tomultiple devices.

n You cannot apply the same static IP address tomultiple devices.

Other issues may or may not be a problem, depending on your requirements for the network.

Applying the Preset
To apply the preset, click OK. Click Cancel to abandon the operation.

Global Configuration
You can use the Presets feature for global configuration, i.e. applying one or more configuration settings to
a number of devices simultaneously.

For example, if you want to apply the same sample rate to all devices on your network:

1. Set one of your devices to the required sample rate.

2. Click the Save Preset button

3. Click None, then select only the relevant device.

4. Click Advanced.

5. Click None, then select the 'Device Sample Rate' checkbox.

6. Click Save.

7. Load the preset (File > Load Preset).
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8. In the 'Preset Roles' column, select the relevant role.

9. In the 'Target Devices' column, click Select All.

10. Click Apply then click OK.

This will set all devices to the same sample rate, but will leave all other device configuration settings
untouched.
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Troubleshooting

Fanout

About Transmit Flows
Transmit flows are 'streams' of audio packets which supply data between devices. Dante devices can
support a finite number of transmit flows, depending on their specific hardware configuration and firmware
version.

Dante supports two types of flows - unicast andmulticast.

Unicast flows are used to supply audio to specific devices, and support 4 channels of audio
simultaneously. So if you subscribe 4 channels on a receiver to 4 channels on a single transmitter, that
audio data will be supplied using one flow. If you were to then subscribe a fifth channel, a second flow
would have to be created.

If you were to subscribe 4 different receivers to the same channel on a single transmitter, Dante Controller
would have to create 4 unicast flows, because the audio data is going to 4 different places. In this case, it
would be better to create amulticast flow.

A multicast flow 'broadcasts' the audio across the network, somultiple receivers can subscribe to the
audio, but the transmitter is only using one of its available flows. Multicast flows can be configured with up
to 8 channels. However, multicast audio traffic can propagate throughout an entire network, using up
bandwidth on every link in the network, even on links where the audio is not required. 100Mbps links in
particular are easily saturated when large numbers of multicast flows exist. Therefore, multicast flows
should only be used when there is a good reason to do so.

If you subscribe a number of devices to one channel via unicast, Dante Controller will alert you with the
followingmessage: “Fanout Configuration detected.”

If you then exceed the supported number of transmit flows, any further subscriptions will fail, and the
tooltip for the failed subscription will read 'Nomore flows (TX): transmitter cannot support any more flows,
reduce fan out by unsubscribing receivers or switching tomulticast.'

Messages on Startup

Error Message Meaning & Actions

'Dante Controller was unable to connect to the
Dante Control andMonitoringmanager. Dante
Controller cannot function without this connection.
This problem is most likely caused by the Dante
Control andMonitoring ('conmon') service or
daemon stopping unexpectedly. Click OK to restart
Dante Controller. Youmay also need tomanually
restart the Dante Control andMonitoring service, or
the computer, if the problem reoccurs.'

Affects: Windows only.
Meaning: The 'Dante Control andMonitoring'
service is not responding. This can occur after a
computer has been in sleepmode.
Action: Restart Dante Controller. In the event that
does not work, reboot your PC, or restart the Dante
Control andMonitoring service via Control Panel >
Administrative Tools > Services.
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Error Message Meaning & Actions

'The installed version [x] of the Dante Control and
Monitoring service (‘ConMon’) is out of date.
This version of Dante Controller requires ConMon
version [x] or later.
Please reinstall Dante Controller to resolve this
issue. Dante Controller will now exit.'

Affects: Windows andOS X.
Meaning: Usually this is because the required
service (ConMon) that is installed with Dante
Controller has been overwritten with an older
version by another Dante software product
installation.
Action: Reinstall Dante Controller. This will update
the ConMon service to the latest version.

'The installed version [x] of the Dante Discovery
service is out of date.
This version of Dante Controller requires Dante
Discovery version [x] or later.
Please reinstall Dante Controller to resolve this
issue.
Dante Controller will now exit.'

Affects: Windows only.
Meaning: Usually this is because the required
service (Dante Discovery) that is installed
with Dante Controller has been overwritten with an
older version by another Dante software product
installation.
Action: Reinstall Dante Controller. This will update
the Dante Discovery service to the latest version.

ComputerConfiguration Checklist
Before installing Dante Controller, youmust be logged in to your computer as a user with administrator
privileges.

To be correctly configured for use with a Dante network, the computer should have:

n Dante Controller installed

n The correct network interface/s selected

n The correct IP addresses in use

Third-party firewall configuration
n StandardWindows andMac firewalls are typically configured on installation.

n Third party firewalls will need to bemanually configured.

If your computer has a third-party firewall installed, please read the Dante Controller and Dante Virtual
Soundcard User Guides for detailed information about firewall requirements and configuration.

Troubleshooting Dante IPAddressConfiguration
All devices in a Dante network, including Dante Virtual Soundcard, must be using IP addresses from the
same network. When using Dante Virtual Soundcard or Dante Controller, your PC orMac must be
connected to the Primary and/or Secondary Dante network, andmust have a correct IP address.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an
error condition, such as an IP address configuration issue, or the device has entered failsafe. Double-
click the red device name to seemore information.
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Correct IP configuration
Dante hardware devices are set to obtain their IP address automatically from the network. They will either:

n Automatically assign themselves an address in the range 169.254.*.* (172.31.*.* for the secondary
network if present), or

n Obtain an IP address from aDHCP server if it is present on the network

Your PC orMac TCP/IP network configuration set should be set to "Obtain an IP address automatically".
This way it will automatically acquire a Link Local automatic IP address in the same network as other
Dante devices. If a DHCP server is present, the computer and Dante devices will all acquire their IP
addresses via DHCP.

Possible IP network configuration mistakes
Possible network configuration errors are listed below. Dante Controller will try to automatically detect
these. If detected the offending device will be displayed in red.

Incorrect PC/Mac IP configuration
n Accidentally havingmultiple network interfaces with addresses in the same subnet

n If your secondary network is using Link Local (no DHCP server), all devices on that network will be
in the 172.31.*.* range. The secondary network interface for the computer must bemanually con-
figured (using static IP addressing) to the same range.

Incorrect general IP configuration
n Accidentally havingmultiple DHCP servers on the same network

Unusual – for example, someonemay have a PC connected to the network with a DHCP server
running that they’re not aware of.

n Incorrectly configured static IP addresses

You shouldn’t typically need to configure static IP addresses at all. If for some reason you do, it
must be in the same subnet as the rest of the network.

Incorrect redundant network configuration
Setting up a redundant network is described in 'Routing Audio'. There are a few ways to incorrectly
configure a redundant network. More than one of these can be present at the same time.

n Connecting the secondary interface of a Dante device to the primary network

Most commonly by either misunderstanding how redundancy works, and using only one switch
with all cables connected to it; or correctly using two switches or networks, but accidentally
connecting one secondary cable to a primary network switch

n Joining the primary and secondary Dante networks

By connecting primary and secondary switches, or perhaps just using one switch.

n Multiple interfaces on the same device using the same IP address subnet

Possibly by having the sameDHCP server on both primary and secondary networks, or both
DHCP servers configured to serve the same IP addresses. Also, mixing DHCP and Link Local on
the same network can cause issues. It is often necessary to have all devices and the computer on
either DHCP or Link Local.



Dante Controller User Guide

Copyright © 2015 Audinate Pty Ltd. All rights reserved. -83-

What are the symptoms of using the wrong network interface on my
computer?
If you havemore than one wired network interface, and Dante Controller is not using the interface the rest
of the Dante devices are connected to:

n Dante Controller cannot see any Dante devices

n Dante Virtual Soundcard is not sending or receiving any audio when it is expected to

How do I check which network interfaces Dante Controller is using?

n The selected network interfaces can be viewed or changed via the 'interface selection' button in
the Network View toolbar of Dante Controller.

n If the Dante network is standalone and does not have a DHCP server installed, the addresses
should be in the range 169.254.*.*

n If the Dante network is using a DHCP server, the IP addresses should conform to the addressing
scheme it is using (as shown in the image above)

How do I check IP addresses for all devices on my network?
n Use the Device Info tab to view the IP addresses of all the devices on your network.

n The Primary Address of all devices should follow the same IP address scheme (e.g. 169.254.*.* or
10.12.0.*). Same for secondary addresses…

n Note that some older Dante devices or devices running older firmwaremay not show this inform-
ation.
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Troubleshooting Switch Configuration and Cabling
Cables are themost vulnerable part of a network system. If you suspect cabling issues, check for:

n Faulty or manually terminated cables

n Unplugged /badly connected Ethernet cables

n Incorrectly configured switches

n Dante devices removed or turned off

Symptoms of switch or cabling issues
n You cannot see (some) devices in the Dante Controller network view

n Dante Controller shows orange “unsuccessful subscription” icons, which usually means a device
that was present earlier is now missing

n Faulty cables can lead to intermittent faults, whichmay be heard as dropped samples or “cracks” in
the audio

n Dante devices may appear and disappear in Dante Controller

Switch and Cabling Checklist
n Are all the connected link/status lights on the switch lit, or flashing as expected?

o Is the switch powered on?

o Is the cable correctly plugged in at the switch and the PC or equipment?

n Is the switch correctly configured?

o Perhaps QoS or VLANs have been incorrectly set up

n Are you using a switch from another application with an unchecked or tested configuration?

o Consult the switchmanual and check the switch configuration
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